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Introduction 

The High Coast system is a hardware platform for configuring and evaluating the Cirrus Logic CS82L4x analog front-end 

(AFE) devices. It comprises the High Coast motherboard (CDB82L4X-MB) and a daughter card. Separate daughter cards 

are available for the 1-channel (CDB82L41-DC), 4-channel (CDB82L44-DC), and 6-channel (CDB82L46-DC) products. 

This document describes the features and usage of the High Coast motherboard CDB82L4X-MB. For descriptions of the 

daughter cards, see their respective user guides. The High Coast motherboard is shown in Figure 1. 

 

Figure 1. High Coast Motherboard (CDB82L4X-MB) 
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1 Daughter Card Connection 

To evaluate the CS82L4x analog front-end (AFE) devices, select and fit the appropriate CDB82L4x-DC daughter card to 

the High Coast motherboard. 

Caution:  

Fully disconnect or power down all external power supplies and disable or remove external clock sources before 

connecting or disconnecting any daughter cards. 

The daughter cards mount to the High Coast motherboard via the DC1, DC2, DC3, and DC4 connectors, see Figure 1. To 

mount the daughter card, ensure the DC1–DC4 connectors of the daughter card align with the respective connectors on 

the High Coast motherboard. Once aligned, apply downwards pressure on each side of the daughter card until seated. 

The correct position and orientation of the CDB82L46-DC daughter card is shown in Figure 2. 

 

Figure 2. CDB82L46-DC Daughter Card Connection 
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2 System Power Requirements and Connections 

The High Coast system must be powered from a 5 V supply, such as from the host USB-C input (J1), a 5 V wall adapter 

via the barrel jack input (P23), or an external power supply via the banana plug/screw terminal connectors (J2 and J3), 

see Figure 3. 

To select the applicable supply, place a 2x2 jumper on the VDD_5V header (P24) in the USB, EXT, or WALL position as 

required, ensuring that the jumper shorts the pins vertically, as shown in Figure 3. 

Note: A 5 V wall adapter or external power supply is recommended for use cases that require more power than the host 

USB port limit. A specification for the 5 V wall adapter is provided in Section 10, Table 5. 

 

Figure 3. High Coast 5 V Power Options 

The 5 V supply is used to power the system and source the internal 3.3 V supplies, INT (internal) and Q (quiet), as shown 

in Figure 4. 

The INT and Q supplies can also be selected as the supplies for the CS82L4x device, see Section 2.1. 

 

Figure 4. INT and Q Supplies 
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2.1 AFE Power 

The CS82L4x is powered from the VDD_A, VDD_IO, and VDD_LDO (CS82L41 and CS82L44 only) supplies. 

VDD_A can be sourced from the High Coast motherboard supplies INT or Q, from an external 3.3 V supply via the 

banana plug/screw terminal connector (J4). Alternatively, for CS82L41 and CS82L44 only, the VDD_A supply can be 

generated from VDD_LDO using the internal regulator LDO4 on the CS82L41 or CS82L44 device. Note: If VDD_A is 

being provided by LDO4, remove the jumper from header P4 to disconnect the external VDD_A supply. 

VDD_IO can be sourced from the High Coast motherboard supply INT, or from an external 3.3 V supply via the banana 

plug/screw terminal connector (J5). Alternatively, for CS82L41 and CS82L44 only, the VDD_IO supply can be sourced 

from the device’s VLDO5 output. Note: LDO5 is powered from VDD_LDO and LDO5 must be enabled to provide an 

output on the VLDO5 pin, see Section 2.2 for further details. 

VDD_LDO (CS82L41 and CS82L44 only) can be sourced internally from the High Coast motherboard supplies INT or Q, 

from an external supply via the banana plug/screw terminal connector (J6), or directly from the 5 V supply. Note: If 

VDD_A is not generated using the internal regulator LDO4, VDD_LDO must be enabled before VDD_A; the VDD_A 

supply must be disabled before VDD_LDO. 

The power multiplexing options of the AFE supplies on the High Coast motherboard are shown in Figure 5. 

 

Figure 5. AFE Power Supply Multiplexing Options 
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To select the sources for VDD_IO (J5), VDD_A (J4), and VDD_LDO (J6), place jumpers on the respective power-

selection headers (P3, P4, and P19), as required. An example selection is shown in Figure 6. 

Note: If VDD_A is being provided by LDO4, remove the jumper from header P4 to disconnect the external VDD_A supply. 

 

Figure 6. AFE Power Headers (P3, P4, and P19) 
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2.2 LDO4 and LDO5 Enable 

This section is applicable for the CS82L41 and CS82L44 devices only. 

LDO4 can be used to generate a 3.3 V analog supply for VDD_A, as described in Section 2.1. LDO5 can be used to 

generate the VDD_IO supply, as shown in Figure 5. Alternatively, the VLDO5 output can power an external sensor, as 

described in Section 4.1. 

The LDO4 and LDO5 regulators are enabled by the LDO_EN pin. Control of the LDO_EN pin is facilitated by the 

VLDO5_EN header (P32), as shown in Figure 7. 

 

Figure 7. VLDO5_EN Header (P32) 

Placing a jumper on the VLDO5_EN header connects the LDO_EN pin to the 3.3V INT supply, enabling the AFE LDO4 

and LDO5 regulators.  

Note: If a jumper is placed on the VLDO5_EN header, an external supply must not be connected to VDD_A, see the 

CS82L41 or CS82L44 datasheet for further information. If a jumper is not placed on the VLDO5_EN header, the LDO_EN 

pin is pulled to GND via a 10 kΩ resistor. 
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3 AFE Clocking 

3.1 MCLK 

An external clock reference (MCLK_EXT) is used to generate the required clocks and timing signals.  

To connect the external MCLK, place a jumper on the MCLK SEL1 header (P42) in the LVDS/SMB position and another 

jumper on the MCLK SEL2 header (P47) in the EXT position, as shown in Figure 8. 

Configuring the P42 and P47 headers as shown in Figure 8, connects the MCLK_P (P30) and MCLK_N (P29) SMB 

connectors to the corresponding MCLK_EXT/MCLK_EXT_P and MCLK_EXT_N pins of the CS82L4x device.  

Note that the configuration shown in Figure 8 is suitable for MCLK input in LVDS or CMOS configuration. In CMOS 

configuration, only the MCLK_P (P30) connection is required. 

Note: CS82L41 supports CMOS MCLK_EXT only. 

 

Figure 8. External AFE MCLK Selection 
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3.2 TGSYNC 

To enable external connectivity of the TGSYNC signal, place a jumper on the TG SRC SEL header (P22) in the SMB 

position, see Figure 9. This selects the TGSYNC_IN (P31) SMB connector as the source of the TGSYNC signal. 

 

Figure 9. External TGSYNC Selection 

The TGSYNC signal can then be routed to the required CS82L4x pin by positioning jumpers on the P13, P14, and P6 

headers. The jumper positions to route the TGSYNC signal to the required pin are detailed in Table 1. 

Table 1. TGSYNC Pin Selection 

Device CS82L4x Pin Jumper Positioning 

CS82L46 or CS82L44 TGSYNC1/VSMP_EXT See Figure 10 

CLKOUT1/LEDR_EN/TGSYNC2 See Figure 11 

CS82L41 LEDR_EN/TGSYNC/GPIO1 See Figure 11 

 

 

Figure 10. TGSYNC1 Selection 

 

Figure 11. TGSYNC2 Selection 

Note: Placing a jumper on the CLK1/TG header (P6) in the CLK1 position connects the relevant CS82L4x pin to the 

SNSR header, see Section 4.3 for full details. 

Note: Jumper position VSMP on the TG/VSMP header (P14) is reserved. 
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4 Sensor Connectivity 

The SNSR header (P40) on the High Coast motherboard provides connectivity to CS82L4x signals that are commonly 

connected to a CCD/CIS imaging sensor. The SNSR header (P40) supports the following connections: 

• V: sensor supply 

• VB: VBIAS 

• C1 to C10: CLKOUT1 to CLKOUT10 

• IN1 to IN6: IN1 to IN6 analog inputs 

The unlabeled connections of the SNSR header are connected to the system GND net, shown in Figure 12. 

4.1 Sensor Supply 

The sensor supply pin, V, on the SNSR header (P40) is a supply voltage, selectable from the internal High Coast system 

supplies, VLDO5, INT, and Q, as described in Section 2. 

To select the required supply, place a jumper on the VSNSR header (P5) in the appropriate position ensuring that the 

jumper shorts the pins as shown in Figure 12. 

 

Figure 12. Sensor Supply Selection 

Note: It is recommended that the LDO5 regulator should not be used to power an external sensor at the same 
time as providing the VDD_IO supply. If LDO5 is used to power an external sensor and VDD_IO, care should be 
taken to ensure VDD_IO noise is within acceptable range for the sensor. For further information, see the 
CS82L41 or CS82L44 datasheet. 

4.2 VBIAS 

The VBIAS pin, VB, on the SNSR header (P40) is connected to the VBIAS pin on the CS82L4x. A voltage reference 

(VBIAS) for the sensor can be generated internally on the CS82L4x, or else can be provided by an external source 

connected to the VB pin. 
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4.3 CLKOUT 

A maximum of 10 configurable clock outputs are available for external circuit timing control. Pins C1–C10 of the SNSR 

header (P40) connect to the applicable CS82L4x pins, as shown in Table 2. Note that C11 is unconnected. 

Note: CS82L44 features four clock outputs (CLKOUT1–CLKOUT4) and CS82L41 features zero clock outputs. The 

alternative SNSR header connectivity of CS82L41 is listed in Table 2. 

Table 2. SNSR Header (P40) C1–C10 Connections to CS82L4x Pins 

P40 Pin Name CS82L46 Pin CS82L44 Pin CS82L41 Pin Jumper Required? Header 

C1 CLKOUT1/LEDR_EN/TGSYNC2 LEDR_EN/TGSYNC/GPIO1 Y P6 

C2 CLKOUT2/LEDG_EN/LED_START LEDG_EN/LEDSTART/GPIO2 Y P8 

C3 CLKOUT3/LEDB_EN/RSMP_EXT LEDB_EN/RSMP_EXT1/GPIO3 Y P7 

C4 CLKOUT4 RSMP_EXT2/GPIO4 N — 

 
C5–C10 CLKOUT5–CLKOUT10 — 

 
— 
 

N — 
 

Pins C1, C2, and C3 of the SNSR header (P40) connect via jumpers to multifunctional pins.  

To select the required connection for C1, C2, and C3, place a jumper on each of the P6, P7, and P8 headers, as shown in 

Figure 13. 

Note: Jumper positions LEDS on the CLK2/LEDS header (P8) and RSMP on the CLK3/RSMP header (P7) are reserved. 

 

Figure 13. SNSR Header (P40) C1–C10 Connections 

4.4 SNSR Analog Inputs 

Pins IN1–IN6 of the SNSR header (P40) can be selected as the analog inputs for the connected CS82L4x device, see 

Section 5.   

http://www.cirrus.com/


 CDB82L4X-MB 

 

DS1402DB2 Cirrus Logic Confidential 12 
 Copyright © 2024-2025 Cirrus Logic, Inc. and Cirrus Logic International Semiconductor Ltd. 

5 Analog Inputs 

Each input channel of the CS82L4x device (IN1–IN6) can be independently connected to one of several sources. 

The input sources are selected by placing a jumper in the required position on the corresponding header. The header 

numbers, corresponding input channels, and supported CS82L4x devices are shown in Table 3. 

Table 3. CS82L4x Input Channels 

Header CS82L4x Input Channel Supported Devices 

P28 IN1 CS82L4x 

P35 IN2 CS82L44 and CS82L46 

P36 IN3 CS82L44 and CS82L46 

P37 IN4 CS82L44 and CS82L46 

P38 IN5 CS82L46 

P39 IN6 CS82L46 

There are three ways to connect an external analog signal source to the input channels of the CS82L4x device: 

• SNSR Header Analog Inputs, as described in Section 5.1 

• SMBC Analog Inputs, as described in Section 5.2 

• Single Channel SMB Input, as described in Section 5.3 

5.1 SNSR Header Analog Inputs 

The SNSR header (P40) can be selected as the external analog signal source. 

To select the SNSR header (P40), locate the header (P28, P35–P39) that corresponds to the required input channel (IN1–

IN6) and place a jumper on the header in the SNSR position. An example showing all six input channels connected to the 

SNSR header (P40) is shown in Figure 14. 

 

Figure 14. SNSR Analog Input Selection 
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5.2 SMBC Analog Inputs 

The IN_EXTC SMB connector (P49) can be selected as the external analog signal source. It provides a common SMB 

connection that can be routed to any of the CS82L4x input channels.  

To select the IN_EXTC SMB connector (P49), locate the header (P28, P35–P39) that corresponds to the required input 

channel (IN1–IN6) and place a jumper on the header in the SMBC position. An example showing all six channels 

connected to the IN_EXTC SMB connector (P49) is shown in Figure 15. 

 

Figure 15. IN_EXTC (P49) SMB Selection 

5.3 Single Channel SMB Input 

The IN_EXT1 (P20), IN_EXT2 (P27), and IN_EXT3 (P48) SMB connectors can be selected as the external analog signal 

source for input channels IN1, IN2, and IN3 respectively. Note: These SMB connections are isolated from all other 

channels and provide the cleanest path from source to CS82L4x device. Use this option if signal integrity and device 

performance are a priority. 

To select the IN_EXT1, IN_EXT2, and IN_EXT3 SMB connectors, locate the header (P28, P35, and P36) that 

corresponds to the required input channel (IN1–IN3) and place a jumper on the header in the SMB1, SMB2, or SMB3 

position respectively. 

An example showing IN1, IN2, and IN3 connected to IN_EXT1 (P20), IN_EXT2 (P27), and IN_EXT3 (P48) is shown in 

Figure 16. 

 

Figure 16. IN_EXT1 (P20), IN_EXT2 (P27) and IN_EXT3 (P48) Selection 
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6 Data Outputs 

The High Coast system supports CMOS and LVDS data output. The data output configuration is set by resistor population 

on the daughter card. For configuration and modification information, see the respective daughter card user guides. 

Note: CS82L41 supports CMOS data output only. 

6.1 CMOS Data Output 

If a CDB82L4x-DC daughter card with CMOS data output is connected to the High Coast motherboard, the digital output 

data is routed to the DOUT CMOS (P43) header. The pinout of this header is shown in Table 4. 

Table 4. DOUT CMOS (P43) Header Pinout 

P43 Pin Number CS82L46 Pin Name CS82L44 Pin Name CS82L41 Pin Name 

1 DOUT1 DOUT1 DOUT1 

3 DOUT2 DOUT2 DOUT2 

5 DOUT3 DOUT3 DOUT3 

7 DOUT4 DOUT4 DOUT4/SPI_SDO 

9 DOUT5 DOUT5 — 

 
11 DOUT6 DOUT6 — 

 
13 DCLKOUT1 DCLKOUT1/DOUT7 — 

 
15 DCLKOUT2 DCLKOUT2/DOUT8 — 

 
17 DOUT7 — 

 
— 
 

19 DOUT8 — 

 

— 

 
21 DOUT9 — 

 

— 

 
23 DOUT10 — 

 
— 
 

The even numbered pins are all connected to the system GND net. The location and pin numbering of the DOUT CMOS 

(P43) header are shown in Figure 17 and Figure 18 respectively. 

  

Figure 17.DOUT CMOS Header (P43) Location Figure 18. DOUT CMOS Header (P43) Pin Numbering 
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6.2 LVDS Data Output 

If a CDB82L4x-DC daughter card with an LVDS data output is connected to the High Coast motherboard, the digital 

output data is routed to the Flat Flexible Cable (FFC) connector (J9), as highlighted in Figure 19. Note: CS82L41 supports 

CMOS data output only. 

Note: The FFC connector manufacturer part number is Molex 5022442430 and the recommended FFC cable is Molex 

150210224 or other 15021xx24 cables. 

To fit the FFC cable, lift the latch (actuator) on the FCC connector (J9), slot in the cable with the electrical contacts facing 

downwards then close the latch. The FFC connector pinout is shown in Figure 20. 

 

  

Figure 19. LVDS FFC Connector (J9) Figure 20. FFC Connector (J9) Pinout 
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7 LEDs 

The High Coast motherboard features red, green, and blue LEDs that can be connected to the LED drivers of the 

CS82L4x. Alternatively, the LED drivers can be connected to external LEDs via the EXT LED header (P21). 

To connect to the LEDs located on the High Coast motherboard, place jumpers on the RED (P10), GRN (P9), and BLU 

(P2) headers in the INT position, see Figure 21. 

To connect to external LEDs via the EXT LED header (P21), place jumpers on headers RED (P10), GRN (P9), and BLU 

(P2) in the EXT position, see Figure 22. 

 

Figure 21. Onboard LEDs 

 

Figure 22. External LEDs 

8 I2C/SPI Device Communication 

Device communication can be performed over a USB-C (J1) connection, or via an external Total Phase AardvarkTM Host 

Adapter connected to the I2C/SPI connector (P44). Both methods support I2C or SPI device communication.  

To enable SPI communication, place a jumper on the SPI_DUT/FPGA header (P1) in the SPI_DUT position. Then select 

the SPI protocol by placing a jumper on the SPI/I2C SEL header (P12) in the SPI position, see Figure 23. 

To select the I2C protocol place a jumper on the SPI/I2C SEL header (P12) in the I2C position. 

Note: CS82L41 supports SPI communication only. 

 

Figure 23. Device Communication Jumper and Connectors 
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9 SoundClear Studio Support 

9.1 SoundClear Studio 

SoundClear® Studio (SCS) is a Windows®/MacOS® application used to configure Cirrus Logic devices. The tools suite 

provides support for evaluation and development and can be used to communicate with the High Coast system over a 

USB-C connection, see Figure 24. 

 

Figure 24. SoundClear Studio 

The latest release of SCS software is available on the Cirrus Logic software portal. Contact your Cirrus Logic 

representative for access.  

Note: By downloading software from the Cirrus Logic software portal, you agree to the terms of our license agreement; 

read the terms before downloading. 

  

http://www.cirrus.com/


 CDB82L4X-MB 

 

DS1402DB2 Cirrus Logic Confidential 18 
 Copyright © 2024-2025 Cirrus Logic, Inc. and Cirrus Logic International Semiconductor Ltd. 

9.2 SoundClear Studio Quick Start Guide 

9.2.1 Installing Packages 

CS82L46, CS82L44, and CS82L41 have separate SCS packages which must be installed after installing the main SCS 

application. These packages can be downloaded from the Cirrus Logic software portal and installed from the main SCS 

application.  

To install the packages, navigate to the File menu and select Install Package…, see Figure 25.  

Note: Select multiple packages in the file dialog to install them concurrently. 

 

Figure 25. SoundClear Studio - Installing Board Packages 

9.2.2 SoundClear Studio User Guide 

To access the SCS User Guide, navigate to the Help menu and select Open Help Contents..., see Figure 26. 

 

Figure 26. SoundClear Studio - User Guide 
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9.2.3 Creating a Virtual System 

A virtual (hardware not connected) version of the system can be created. This enables interaction with virtual versions of 

the CS82L4x device register map and helper panels. 

To create a virtual version: 

1. In the Systems menu select Add Virtual System..., see Figure 27. 

 

Figure 27. SoundClear Studio - Creating a Virtual System 

2. In the Add Virtual System dialog, select Add an installed system. 

A list of the installed daughter card packages is presented in the Add Virtual System dialog. Select the required daughter 

card to define the virtual system. An example showing the CDB82L46 daughter card is shown in Figure 28. 

 

Figure 28. SoundClear Studio - Adding a Virtual System 

3. Click ADD. 

  

http://www.cirrus.com/


 CDB82L4X-MB 

 

DS1402DB2 Cirrus Logic Confidential 20 
 Copyright © 2024-2025 Cirrus Logic, Inc. and Cirrus Logic International Semiconductor Ltd. 

9.2.4 Adding an Existing System 

An existing (hardware connected) system is automatically detected by SCS. 

In the event of the system not being detected automatically, the CS82L4x device can be added manually. 

To manually add the CS82L4x device: 

1. In the Navigator tab, right click on the unknown system and select Add Device…, see Figure 29. 

 

Figure 29. SoundClear Studio - Adding an Existing System 

In the Add New Device dialog a list of devices (provided by the installed package) is presented. 

2. Select the device, along with the required protocol and device address, see Figure 30. 

Note: After adding a new device, the device address can be edited. See the SCS User Guide. 

 

Figure 30. SoundClear Studio - Selecting Device to Add 

3. Click ADD. 
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9.2.5 Executing SoundClear Studio Scripts 

SCS provides the ability to interact with the device register map using Python scripts. These scripts can sequence register 

operations to configure the device into desired states.  

To execute the SCS scripts, in the File menu, select Execute Script, see Figure 31. 

 

Figure 31. SoundClear Studio - Execute Script 

The daughter card SCS package installs a set of scripts to configure the device for common use cases. These are 

available at <User Documents>\Cirrus Logic\SCS\Scripts\<Device Name>. 

To access the applicable <User Documents> folder, in the File menu select Show User Script Folder → <Device 

Name>, see Figure 32. 

 

Figure 32. SoundClear Studio - Show User Script Folder 
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10 Appendix A–5 V Wall Adapter Specification 

Table 5. 5 V Wall Adapter Specification 

Parameter Value 

Voltage +5 V tip 

Max Output Current ≥4 A 

Barrel Inner Diameter 2.1 mm 

Barrel Outer Diameter 5.5 mm 

Barrel Length 12 mm 
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11 Revision History  

Revision History  

Revision Changes 

R1 

OCT 2024 

 •  Initial version.   

R2 

MAY 2025 

 •  Updated for release of CDB82L41-DC daughter card. 

 •  Updated for release of CDB82L4X-MB-REV-B motherboard. 
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Contacting Cirrus Logic Support 

For all product questions and inquiries, contact a Cirrus Logic Sales Representative.  

To find the one nearest you, go to www.cirrus.com. 

IMPORTANT NOTICE 

The products and services of Cirrus Logic International (UK) Limited; Cirrus Logic, Inc.; and other companies in the Cirrus Logic group (collectively 

either “Cirrus Logic” or “Cirrus”) are sold subject to Cirrus Logic’s terms and conditions of sale supplied at the time of order acknowledgment, 

including those pertaining to warranty, indemnification, and limitation of liability. Software is provided pursuant to applicable license terms. Cirrus 

Logic reserves the right to make changes to its products and specifications or to discontinue any product or service without notice. Customers should 

therefore obtain the latest version of relevant information from Cirrus Logic to verify that the information is current and complete. Testing and other 

quality control techniques are utilized to the extent Cirrus Logic deems necessary. Specific testing of all parameters of each device is not necessarily 

performed. In order to minimize risks associated with customer applications, the customer must use adequate design and operating safeguards to 

minimize inherent or procedural hazards. Cirrus Logic is not liable for applications assistance or customer product design. The customer is solely 

responsible for its overall product design, end-use applications, and system security, including the specific manner in which it uses Cirrus Logic 

components. Certain uses or product designs may require an intellectual property license from a third party. Features and operations described 

herein are for illustrative purposes only and do not constitute a suggestion or instruction to adopt a particular product design or a particular mode of 

operation for a Cirrus Logic component. 

CIRRUS LOGIC PRODUCTS ARE NOT DESIGNED, TESTED, INTENDED OR WARRANTED FOR USE (1) WITH OR IN IMPLANTABLE 

PRODUCTS  OR FDA/MHRA CLASS III (OR EQUIVALENT CLASSIFICATION) MEDICAL DEVICES, OR (2) IN ANY PRODUCTS, APPLICATIONS 

OR SYSTEMS, INCLUDING WITHOUT LIMITATION LIFE-CRITICAL MEDICAL EQUIPMENT OR SAFETY OR SECURITY EQUIPMENT, WHERE 

MALFUNCTION OF THE PRODUCT COULD CAUSE PERSONAL INJURY, DEATH, SEVERE PROPERTY DAMAGE OR SEVERE 

ENVIRONMENTAL HARM. INCLUSION OF CIRRUS LOGIC PRODUCTS IN SUCH APPLICATIONS IS UNDERSTOOD TO BE FULLY AT THE 

CUSTOMER’S RISK AND CIRRUS LOGIC DISCLAIMS AND MAKES NO WARRANTY, EXPRESS, STATUTORY OR IMPLIED, INCLUDING THE IMPLIED 

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR PARTICULAR PURPOSE, WITH REGARD TO ANY CIRRUS LOGIC PRODUCT THAT IS USED 

IN SUCH A MANNER. IF THE CUSTOMER OR CUSTOMER’S CUSTOMER USES OR PERMITS THE USE OF CIRRUS LOGIC PRODUCTS IN SUCH A 

MANNER, CUSTOMER AGREES, BY SUCH USE, TO FULLY INDEMNIFY CIRRUS LOGIC, ITS OFFICERS, DIRECTORS, EMPLOYEES, DISTRIBUTORS 

AND OTHER AGENTS FROM ANY AND ALL LIABILITY, INCLUDING ATTORNEYS’ FEES AND COSTS, THAT MAY RESULT FROM OR ARISE IN 

CONNECTION WITH THESE USES. 

This document is the property of Cirrus Logic, and you may not use this document in connection with any legal analysis concerning Cirrus Logic 

products described herein. No license to any technology or intellectual property right of Cirrus Logic or any third party is granted herein, including but 

not limited to any patent right, copyright, mask work right, or other intellectual property rights. Any provision or publication of any third party’s products 

or services does not constitute Cirrus Logic’s approval, license, warranty or endorsement thereof. Cirrus Logic gives consent for copies to be made of 

the information contained herein only for use within your organization with respect to Cirrus Logic integrated circuits or other products of Cirrus Logic, 

and only if the reproduction is without alteration and is accompanied by all associated copyright, proprietary and other notices and conditions 

(including this notice). This consent does not extend to other copying such as copying for general distribution, advertising or promotional purposes, or 

for creating any work for resale. This document and its information is provided “AS IS” without warranty of any kind (express or implied). All statutory 

warranties and conditions are excluded to the fullest extent possible. No responsibility is assumed by Cirrus Logic for the use of information herein, 

including use of this information as the basis for manufacture or sale of any items, or for infringement of patents or other rights of third parties. Cirrus 

Logic, Cirrus, the Cirrus Logic logo design, and SoundClear are among the trademarks of Cirrus Logic. Other brand and product names may be 

trademarks or service marks of their respective owners. 
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